Updating McCormick Master's Program Sites in Cascade
A Guide for Site Administrators

By the McCormick Office of Marketing and Communications and IT Resources

Version 2.0
Updated August 5, 2021
### Contents

What's Responsive? ........................................................................................................... 6

Module 1: Cascade Basics I – Getting Familiar .......................................................... 10

  Logging in to Cascade ............................................................................................... 10

  The Home Screen ..................................................................................................... 11

  The Toolbar .............................................................................................................. 12

    The Sites Menu ...................................................................................................... 13

    The Add Content Button ....................................................................................... 14

    The Navigation Panel ............................................................................................ 16

    The Contextual Menu ............................................................................................ 17

    The Trash Bin ...................................................................................................... 17

  The Dashboard ......................................................................................................... 18

    My Sites Widget ................................................................................................... 18

    My Upcoming Tasks Widget ................................................................................ 19

    New Content Widget ............................................................................................ 20

    My Content Widget .............................................................................................. 21

    Stale Content Widget ........................................................................................... 21

    Notification Widget ............................................................................................... 23

    Reconfigure Dashboard ......................................................................................... 23

Assets ......................................................................................................................... 23

    Naming Files, Folders, and Webpage Assets ....................................................... 24

Module 2: Editing a Basic Page ..................................................................................... 25

  Page Location/URL .................................................................................................. 26

  Inline Metadata ....................................................................................................... 26

  Header Image/Slider ............................................................................................... 27

  Jump Menu ............................................................................................................. 28

Editor Toolbar - WYSIWYG ......................................................................................... 30

  Basic Formatting ..................................................................................................... 32

  Headings and Subheadings ...................................................................................... 32

  Copying and Pasting ............................................................................................... 33

  Inserting and Editing Links ..................................................................................... 34
Anchor Links ........................................................................................................................................... 35
Sidebar Options ........................................................................................................................................ 36
Draft ......................................................................................................................................................... 40
Save & Preview Vs. Submit ....................................................................................................................... 41
Submit Vs. Publish .................................................................................................................................... 41
Publishing or Un-publishing Your Assets ............................................................................................... 42
Publishing the Top Navigation .................................................................................................................. 45
Writing for the Web .................................................................................................................................. 45
  Optimize Asset Names ............................................................................................................................ 46
  Use Descriptive Page Titles .................................................................................................................... 47
  Include Metadata ...................................................................................................................................... 47
  Optimize Your Copy ................................................................................................................................. 47
  Use Headers and Subheaders ................................................................................................................... 48
  Link Frequently and Use Keywords ......................................................................................................... 49
  Use Alt Tags on All Images .................................................................................................................... 50
Module 3: Images, Documents & Videos ................................................................................................. 51
  Preparing Images .................................................................................................................................... 51
  Uploading Image/Doc ............................................................................................................................... 52
  Inserting an Image on Page ...................................................................................................................... 54
  Working with Images ............................................................................................................................... 56
    Assigning an Image Class ....................................................................................................................... 56
    Aligning an Image to the Right or Left ................................................................................................. 56
    Editing and Replacing Images ................................................................................................................ 57
  Inserting Video on Page ........................................................................................................................... 58
  Image/Video Size Cheat Sheet ................................................................................................................ 59
  Header Images .......................................................................................................................................... 60
  Images in Body Area of Basic Pages ....................................................................................................... 60
  Images on People Listings Pages ............................................................................................................ 60
  Images in Sidebar Features ..................................................................................................................... 60
  Videos in Body Area of Basic Page ......................................................................................................... 60
Module 4: Cascade Basics II – Structural Additions/Changes ................................................................ 62
Creating Section Folders ........................................................................................................... 62
Editing Index Pages .................................................................................................................. 65
Creating Webpages (Second-Level Navigation) ................................................................. 66
Creating Third-Level Navigation ............................................................................................ 67
Folder Order: Changing Your Site’s Navigation ................................................................. 68
Copying Folders/Files .............................................................................................................. 68
Moving Folders/Files ............................................................................................................... 68
Renaming Folders/Files .......................................................................................................... 71
Publishing Folders/Files ......................................................................................................... 72
Deleting Folders/Files ........................................................................................................... 73
Development Server .............................................................................................................. 73
Module 5: Program Page Types ............................................................................................. 74
People Listing .......................................................................................................................... 74
Faculty Listing ......................................................................................................................... 80
Faculty Profiles ....................................................................................................................... 84
   Budgetary / Tenure-track Faculty Profiles (e.g. Core faculty) .............................................. 84
   Affiliated Profiles ................................................................................................................ 90
Student Profiles ....................................................................................................................... 94
Student Listing Pages .............................................................................................................. 96
News Articles ............................................................................................................................ 97
News Article Sidebar ............................................................................................................... 101
News Index .............................................................................................................................. 103
Event Listing ............................................................................................................................ 104
Course Listing ........................................................................................................................... 105
Course Description .................................................................................................................. 107
   Create a new description .................................................................................................... 107
   Choose an existing description ......................................................................................... 109
Homepage ............................................................................................................................... 111
   Section Formats ................................................................................................................ 114
   Section Content ............................................................................................................... 115
   Section Order .................................................................................................................... 115
Section Headers .................................................................................................................. 115
Section Separator ................................................................................................................ 116
Callout Section ..................................................................................................................... 117
Events Section ..................................................................................................................... 121
Features Section .................................................................................................................. 122
News Section ....................................................................................................................... 124
Programs Section ................................................................................................................. 127
Testimonial / People Feature Section .................................................................................... 129
WYSIWYG + Images / Video / Sidebar List Section ............................................................ 132
WYSIWYG w/ Buttons Section ............................................................................................. 138
Quick Facts Section ............................................................................................................... 140
Whole Brain Footer Section—Controlled by Marketing....................................................... 142
Module 6: Other Helpful Tips ............................................................................................... 143
Mark Content for Review ..................................................................................................... 143
Versions ............................................................................................................................... 144
Creating Line or Paragraph Breaks ....................................................................................... 145
Basic Troubleshooting .......................................................................................................... 145
What’s Responsive?

Today, you can access websites on a desktop, laptop, tablet, mobile phone and other devices, each with varying screen sizes. Responsive design is a method of creating a flexible or fluid website layout that will adapt to any size screen.

The layout of the page changes and items, shrink, shift around and collapse as the viewing screen size decreases. Because the layout transforms for different screen sizes, it’s important not to refer to things on the page as “to the left,” “above,” “below,” or “to the right.” The position may change. It’s also very important to follow guidelines illustrated in this manual for headers, image sizes, etc. to ensure the site looks good and performs well on different devices.

Take a look at how the basic page transforms as the screen decreases from desktop size down to mobile:
At tablet size, the right sidebar is not present. Instead:

- Breadcrumbs turn into collapsible menu
- The sidebar feature no longer displays
- Related Info and Contact Info areas move to the bottom of the page
At mobile size, the feature slideshow becomes one static image w/o caption. And the site's navigation is accessed via menu bar icons.

The left navigation and breadcrumbs are now expandable from the blue Section Menu.

The main site navigation can be expanded by clicking the purple menu bar icon at the screen's top right.
Module 1: Cascade Basics I – Getting Familiar

Logging in to Cascade
Open a browser and enter the following URL (or click this link):
http://wcms.northwestern.edu/

You will be redirected to the NU Online Passport Single Sign-On page.
Enter your Net ID and password. Then press “Enter” or click “Log In.” Click “Continue” if a security warning message pops up.

![Security Warning]

Although this page is encrypted, the information you have entered is to be sent over an unencrypted connection and could easily be read by a third party.

Are you sure you want to continue sending this information?

This security warning is not an indicator of an actual security threat; it can safely be ignored while using Cascade.

![Information]

You're logged in.

NOTE: On occasion after logging into Cascade, your browser may indicate you are logged in, but not take you to Cascade’s Home Screen. Should this error occur, simply return to the login URL (http://wcms.northwestern.edu/) and your browser will automatically redirect you to the Home Screen, so you can begin working in Cascade.
The Home Screen

The first thing you'll see upon logging in to Cascade is the Home Screen, which serves as a sort of home base for your work while logged into Cascade.

The Home Screen consists of two main areas:

- The **toolbar**, which runs across the top of the screen, allows you to perform some actions, such as returning to the home screen and navigating to a specific website.

- The **dashboard / main panel**, which takes up the majority of the screen, changes according to the task you are performing. It offers a view of helpful site widgets that users can add, remove or move.

---

**Best Practice:**
McCormick IT recommends Cascade users work in Chrome or Firefox. Internet Explorer also works, but Chrome and Firefox generally perform better. **Mac users** are also advised to use Chrome or Firefox.

When previewing changes to your website in a browser, it is suggested to avoid using Firefox since you may need to force its cache to refresh in order to load your site's latest content changes.
**The Toolbar**

The Cascade’s toolbar in the Home Screen has been simplified to contain several functions.

Some toolbar items are simply buttons; others are drop-down menus (indicated by a double downward arrow).

The functions available in the Toolbar are similar to those found on the Dashboard, but are consistently available.

- The **Cascade Crescent** menu leads you to the Home Screen dashboard, with user-defined widgets.
- The **Sites** menu gives you a drop-down list that displays the accessible websites, and also a search bar to filter the sites list.
- The **My Content** button is used to show you content-related lists of recently viewed assets, content ownership, drafts, assigned tasks and more. This button appears in the Help menu at smaller screen sizes.
- The **Search** menu provides a function to search for website assets and a shortcut to a list of most recently viewed assets in the My Content section.
- The **Help** menu allows you to get in-system help such as reports and get to the Cascade knowledge base for more technical information.
The Sites Menu

You’ll notice a drop-down menu at the upper left of the Home Screen that says “SITE: Go to a Site” by default. Clicking the down arrow on the menu tab reveals the sites you have access to view and edit in Cascade. Also, you can type keywords to filter the site list.

Once you choose a website, then you are redirected to the Site Content page as below.

- Unlike the one in the Home Screen, the **Toolbar** menu on the Site Content page allows you to add website content through the **Add Content** button.
• The **Navigation Panel** window permits you to navigate the website content. You can hide this panel at any time by clicking the arrow icon.

• The **Site Content** window displays content details and previews.

**The Add Content Button**
The Add Content button is available when you browse to a certain site mainly through “SITE: Go to a Site” drop-down menu, or a recent history link in “My Content >> Recent” Widget. In the drop-down menu, you can either search for the site you’d like to navigate to, or simply click it. In the My Content >> Recent Widget, you can click a link to the site.
If you click the Add Content button, a drop-down menu will appear. You can either search for the name of an asset you’d like to create in the search bar, or select an asset from the list.

![Add Content Menu]

There is a shortcut for creating a new asset in the New Content Widget of the Dashboard. See [New Content Widget](#) section of this document for further instructions.
**The Navigation Panel**

The navigation panel uses the “tree” structure that will be familiar to any user of Windows: a listing of folders is visible, and the user clicks on each folder to view its contents. Clicking the folder expands or contracts that folder’s contents, as shown below.

To begin browsing the site in Cascade, click on a folder in the navigation panel to expand the folder tree. Once the folder expands, the sub-folders and page assets are displayed in the same directory structure that exists when published. Choosing a page in the folder, such as “index”, will bring up a preview of the web page in the site content window, just as it would appear online.
The Contextual Menu
When you right-click on an asset, the contextual menu is displayed for that asset. The contextual menu is a shortcut that allows you to quickly jump into editing and other functions available in the content page Toolbar, without waiting for the page preview to be loaded in the Site Content window first.

The Trash Bin
The Trash Bin contains assets you and other site users have recently deleted. These assets are kept in case of accidental deletion. Note that assets in the Trash Bin are deleted permanently after 15 days.

Access the trash bin on top of the navigation panel.

To restore an asset to its original location, select the asset and click the leftward curve icon on top of the Trash list.
The Dashboard

My Sites Widget
If you have access to more than one site in Cascade, you will see a list of recently visited sites under the My Sites widget. This allows you to quickly navigate to the site(s).
**My Upcoming Tasks Widget**

This is a new feature in Cascade 8. You can also create a task by clicking **Add a Task** button. When you click add a task button, a pop-up window appears where you can enter a **Name** for the task, a **Description**, **Assigned User** (by default it’s assigned to the person creating the task), set a **Priority**, enter a **Due Date** and list any **Related Content** (for example –a file or image, or a webpage)
New Content Widget
This widget provides a shortcut to create new content on your site. All available asset types are listed. If you’re logging in for the first time, to see available assets, click the pencil icon that appears in the top right corner when you hover over the widget to configure it for a website you have access to.

Select the appropriate asset type from the icon list when you need to create a new webpage, or create a folder, or upload a new file.
My Content Widget
You’ll find a list of recently clicked assets under Recent, saved drafts under Drafts and assets that you’ve checked out to yourself under Locks. Most of our sites don’t have Workflows. Just switch to the appropriate subtab to see the relevant content.

By default, Recent is displayed in the My Content section at the center of the Dashboard. There are other ways to get access to Recent.

Stale Content Widget
Stale content widget shows you when the site content was last updated. If you’re logging in for the first time, click the pencil icon in the top right corner to select your site and set the time period to determine content staleness.

After you’ve configured it, you will see a chart showing the number of stale vs fresh assets. You click on the link Showing total assets last updated 30 or more days ago to see a full list.
If you expand **Filter Results** option, you'll see the options to change the number of days and include the folder you need to routinely update. In this way, you can exclude sections that don’t get updated often.
Notification Widget
The Notifications widget lists messages related to publishing and un-publishing of an asset. Any errors or issues with your publishing jobs will be logged here.

Reconfigure Dashboard
- You can drag and drop widgets to rearrange them on your dashboard.
- You can add/remove widgets by clicking on Add Widget button.

Assets

What’s an Asset?
In Cascade, the word “asset” is a blanket term for any object loaded into, or created in, the Content Management System.

An asset can refer to:
- a web page
- a PDF
- an external link
- an image file (photo)
- an MS Word document
- an internal link
- a folder
- an MS Excel document
Naming Files, Folders, and Webpage Assets

Since asset filenames become part of their URL addresses and also affect how readily your website appears in search results, it is important to follow certain conventions as you name your assets in Cascade.

When providing the **Asset Name** in Cascade, please follow these guidelines:

- Asset Names should not contain any spaces and should not be unnecessarily long.
- They should use keywords, all lowercase, separated by hyphens.
- They should not include dates that will expire.

Here are examples of good and bad Asset Names:

<table>
<thead>
<tr>
<th>GOOD</th>
<th>BAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>catalysis-research-laboratory.jpg</td>
<td>CatResclab.jpg</td>
</tr>
<tr>
<td>john-smith.jpg</td>
<td>John Smith Good Headshot1.jpg</td>
</tr>
<tr>
<td>john-smith-publications.pdf</td>
<td>Johnsmith_Pubs_9-12-11.pdf</td>
</tr>
<tr>
<td>smith-group-newsletter.pdf</td>
<td>SmithResearchgroupNewsletterApril2012.pdf</td>
</tr>
</tbody>
</table>

Following good hygiene when naming your assets also saves you time and trouble as you organize and maintain your website content in Cascade.
Module 2: Editing a Basic Page

To edit a basic page, select that page from the left-hand navigation tree in the content page. Then choose "Edit." This will bring up the editing view of the page. Here's a look at the editing view of the "About McCormick" page of the site:
Page Location/URL
At the top of the site content window, you'll notice the indication of the page's location in a path directory format: about/index.

This indicates that the page has an Asset Name of "index" and is located in the "about" folder. It also indicates what the page's url is: http://mccormick.northwestern.edu/about/index.html

Note: Because this is an index page, http://mccormick.northwestern.edu/about/ will also direct to this page.

Inline Metadata
When editing an existing page, you'll notice the "Inline Metadata" section is filled in with the page's "Display Name," "Title," etc. The Display Name appears in the left navigation of the site and the "You Are Here" breadcrumbs. The title appears on the actual page.
Learn more on how to fill out this section in the "Include Metadata" subsection of this guide.

**Header Image/Slider**

If you would like to include a header image or slideshow at the top of the page, click the downward arrow \( \vee \) to expand the Main Content > Header Image(s)/Slider section.

As you answer the series of "Yes/No" questions about your image(s)/slideshow, options will appear to further indicate specifications such as:

- one header image or a multi-image slider
- automatically cycle through images on the page or leave it up to the user to advance the slideshow
- advance slides every 20 seconds (default) or for a number of seconds you specify
If you've chosen to create a multi-image slider, the area to add the image and caption for each slide will appear below the options:

Click the downward arrow ∨ to expand this section and edit the fields for the slides. Add more slides by clicking the green plus sign + at the top right of the expanded slide area.

**Jump Menu**
The basic page type has a Jump Menu option to create a list of links to various sections of the page. This is ideal for lengthy pages on a responsive site so mobile users can skip to the information they’re looking for rather than scrolling through all the page’s content.

To use this menu, select "Yes" for "Include jump menu?" Click the "∨ Jump Menu" box that appears. You'll first notice an area for optional Preface Content, which would
appear above the jump menu on the page. Use this area for an introductory message to your page if necessary.

Below is the area to create your menu links. You must fill in the field for the link **Text** (the text that will appear in the menu on the page) and the **Anchor Name** (the section of the page you want to jump to). Then, **you must create anchors with the same names** used in the Body Content section in the area of the page you wish to link to. See the "Anchor Links" section of this guide to learn how to create anchors.
Editor Toolbar - WYSIWYG

Since Cascade uses a WYSIWYG (What You See Is What You Get) editor, the formatting you apply to your content is generally how it will appear on your website.

Cascade’s editor toolbar lets you apply the same basic formatting you’d have access to in any word processor — headers, paragraph (body) copy, bulleted and numbered lists, bold, italics, and much more.

Many of the options on the Cascade editor toolbar (especially the ones on the left side) will be familiar to users of common word processing software. You can perform many of the same actions to format text as you can in a program like Microsoft Word.

There are six drop-down menus in the toolbar as follows:

- **Edit** menu allows you to edit content through undo, redo, cut, copy, paste, paste as text, and select all functions.

- **Format** menu enables you to set the format of content to bold, italic underline, strikethrough, superscript, subscript, and to clear the formatting. You can also access the Formats menu.

- **Insert** menu contains functions to include links, anchors, images, media, special characters, horizontal lines, and data/time.

- **Table** menu allows you to insert and edit tables. It is advised to **not use tables on the site**. If you have information that absolutely needs a tabular display, please contact marketing at web-updates@mccormick.northwestern.edu.
• **View / Tools** menus provide functionality to help users in terms of view, spellcheck, and source code.

Also, there are some shortcut tools – noted in the graphic above – that may require some additional explanation with regards to how they function.

**Link/Unlink:** These tools will allow you to create/edit hyperlinks out of any text or image within your body content.

**Insert/Edit Anchor:** Anchors allow you to mark points anywhere on your web page so that they can be easily accessible by users. They are most often used on web pages with a large amount of content, as they offer the ability to go directly to a single piece of content rather than scrolling down through the entire page.

**Insert/Edit Image:** Select this icon to insert an image into your page. Please read the “Inserting Images” section of this manual for important information on this process [page 00].

**Insert/Edit Video:** Select this icon to insert a video into your page. Please read the “Inserting Videos” section of this manual for important information on this process [page 00].

**Edit HTML Source:** This option allows you to take a look “under the hood” at the actual code that you’re creating through the Cascade editor. However, it is advisable to leave this alone unless you are familiar with HTML code – changes made here can affect the functionality of your site.

**Full screen Mode:** Clicking this icon will move your view to a full screen mode in your browser to allow for added working space. Click the icon again to return to the standard view.

**Set / Edit Formats:** Clicking this drop-down menu will provide a shortcut to set or edit headings, inline, blocks, alignment, and custom classes.

**NOTE:** You will notice buttons in the editor toolbar to “underline,” “underline,” and “indent” text in the editor window. Those styles are **not** preserved when you submit your page in Cascade and will not publish.
**Basic Formatting**

Formatting text as bold, italic, underline, and setting its alignment to left, right, or justified, works the same in Cascade as it does in any word processor: Simply select the appropriate text, then apply the formatting you want it to have.

**NOTE:** Cascade is currently configured to remove the “centered” formatting available in the WYSIWYG editor. If you want to center-align any text, use the “Formats” drop-down menu as explained earlier.

**Headings and Subheadings**

It is important to keep your content well organized so your visitors can easily navigate and find the information they need. Use headings and subheadings on your pages to create a visual hierarchy for your visitors, similar to a document outline.

To create a heading in Cascade, select the text you wish to use as a header, then, in the Cascade Editor window, click the “Formats” drop-down menu and then “Headings” menu. Finally, select “Heading 2” or “Heading 3.”

The importance of a heading descends as its number ascends, so information used as a Heading 2 should be more important than that of a Heading 3.

**Best Practice:**

**Use Headings and Subheadings Frequently!**

- Use “Heading 2” to make a header in your page’s main content area.
- Use “Heading 3” to make a subheader in page’s main content area.

For additional information on using headings and other formatting to improve your website’s searchability, read the section of this guide titled “Optimizing Your Content”.

**NOTE:** With this website template, you should not use any “Heading 1” or “Heading 2” formatting, since Cascade automatically formats your site and page titles to those headings.
**Copying and Pasting**

As you build and maintain your webpages in Cascade, you can type in your content by hand using the WYSIWYG content editor. You may find you need to input larger amounts of content from Microsoft Word documents or Adobe PDF files.

Before copying and pasting any content into Cascade, please review the following:

In most cases, **copying and pasting directly from Word or PDF documents into Cascade is not recommended**. Documents from word processing programs often contain hidden formatting which can create errors in the way content is displayed on the web.

To remove hidden formatting, it is recommended that you select the **“Paste as Text”** located in the Edit drop-down menu in the toolbar. With that button selected, text you paste into Cascade will automatically be stripped of any hidden formatting.

Another option you could use is to **first paste your content into a plain text editor** such as TextEdit or Notepad. Make that content “plain text,” and then copy and paste it again from there into Cascade. That process will strip any hidden code that you may accidentally include with your content.

**Whenever you paste or enter text into Cascade, you will need to reformat your text using the tools in Cascade’s editor toolbar**, creating headers, paragraphs, links, and other formatting manually as desired.

Making sure your text is pasted into Cascade as plain text will ultimately save you a lot of trouble later and ensure that your content appears exactly how you would like it to appear on the web.
Inserting and Editing Links

To create a hyperlink on a line of text or an image, highlight that piece of text or the image you’d like to link and click the chain-link button in the Cascade editor toolbar.

From there, you will need to specify the following:

- whether the link target is an internal page or an external URL
- whether the link will open in the same window or in a new window
- what the link’s title (which appears as the floating “tool tip” when a user hovers over link text) will be

**NOTE:** External links that go to webpages that are not part of your own site should open in a new window. Internal links to pages on your site should stay in the same window.

To create a link to someone’s email address, select the external link option and type “mailto:” followed by the desired email address in the URL field. For example, if you wanted to link to John Smith’s email address, type “mailto:john.smith@northwestern.edu” (without quotes) in the external URL field. In the “Title” field, enter something like “E-mail John Smith.” When a visitor clicks on that link on your website, their default email program will open a new email to that email address.

You can also use this tool to point to a page anchor, which is discussed in more detail below.

To edit a link, select the link in your editor window and click the chain-link button in the editor toolbar. You can modify the link’s attributes there.

To remove a link, select the link in your editor window and click the broken chain-link button in the editor toolbar.
**Anchor Links**

Anchors allow you to mark specific points anywhere on your webpage that can be linked to from external pages. For example, using an anchor link, it would be possible to link to, say, the third paragraph of a page, rather than the top of that page.

They are most often used on Web pages with a large amount of content, as they offer the ability to go directly to a single piece of content rather than scrolling down through the entire page. For example, the “back to top” links often used in long lists are actually pointing to the same page anchor at the top of the page.

**To insert an anchor:**

1. Go to the area of the page where you want the anchor to be (usually near a heading) and click the anchor tool.

2. Enter an anchor id (name) and click “Ok.” **Anchor names must start with a letter** and cannot include spaces.

3. When you want to link to that specific section from a table of contents at the top of the page:
   
   a. Use the link tool as you would for an ordinary link, but rather than choosing an external page to link to, enter the name of the anchor link on the current page.

4. When you want to link to an anchor on a page other than the one you’re currently editing:
   
   a. Use the Link tool to select the page elsewhere in the site.
   
   b. Enter the name of the anchor link on that page in the “Anchor” field.
Sidebar Options

All pages have a right sidebar at desktop size. You can include the following 5 widgets:

- Calls to Action (optional)

The "Apply Now" and "Request Info" call to action buttons display at the top of the sidebar on every page of the website, unless you choose to hide them. You can display both, one, or neither on all pages.

To edit what displays on all pages, you can navigate to the Sidebar >> Calls to Action section in the editing window of any page. Click the path box that appears below “Choose an existing call-to-action block”.

Alternatively, you can navigate directly to the "calls-to-action" folder in the left navigation tree and edit the block:

A new editing window will open for the call to action buttons. In this window, you can edit the links for each button. The buttons' text cannot be edited. You can also select to hide them. To make updates to this block live on the site, publish the Site Name folder.
Lastly, you can create additional call to action buttons by going to Add Content à Call to Action Buttons. Once the details are filled out and submitted, the block will be stored in the calls-to-action folder with the default on already on your site. The default block on any page can be replaced with any new ones created.
• Related Links (optional)
  o Select “Yes” for “Include related info?” then click "∨ Related Links". Enter content for links. Click the green plus icons + to add another group/individual links.

• Contact Info (required)
  o Enter contact information. Click the green plus icons + to add another group/individual contacts.
• Call-out (optional)
  o Fill out the Header and Content regions

• Sidebar Feature (optional)
  To add, select "Yes" for "Include a Sidebar Feature?" Then, click the "√ Sidebar Feature" box. You can create a feature for the specific page you're editing or use a feature block, which can be added to multiple pages.
  o Create a feature:
    Select an image with dimensions 242 by 170px and fill out the Header and Content regions. Select the "Link Type" if you want the feature to link to another page. To add slides, click the green plus sign at the top right.
  o Feature block: Select this option if you would like to insert a general sidebar feature block for more than one page. Sidebar feature blocks are stored in the “sidebar-features” folder and each will have a block icon.

To create a new general sidebar feature:

1. Go to “Add Content à Sidebar Feature” and give your general feature a descriptive Asset Name.
2. Fill in the appropriate fields for your slide(s) and submit.
3. Publish any image assets added to the block separately. Unfortunately, the images won’t appear in the sidebar slideshows if you have not published them separate from the page(s) you add the block to.
4. The feature-block will be stored in the “sidebar-features” folder and you can choose to add it to any page by selecting the Feature block sidebar option.
Draft

A “Draft” is exactly what the name implies: a working, but not complete, copy of a webpage with changes in progress. Drafts are automatically created and periodically updated as you work on a page.

To save a page as a draft, click the “Save & Preview” button at the top right of the Edit window. This allows you to view your draft after saving it.

Drafts are useful when you’re working on a page but need to stop and focus on something else for a while. If you go back in Edit mode, you’ll see a yellow bar with three options:

a. **Preview the changes** – If you click here, you see a preview of your draft. You can also see a preview of the last saved version from here.

b. **Resume editing** – allows you to edit your draft.

c. **Discard it** – if you click here, your draft will be discarded

You can find all saved drafts under the My Content widget on your Dashboard.

---

**Important:**
You are the only person who can see your draft of a page.

If you’ve made changes to a page but saved it as a draft (instead of clicking “Submit”), other users will not be able to see your changes when they open the page.

If you need another user to see your changes, go ahead and click “Submit” — it’s easy to roll back changes in Cascade, if needed.
Save & Preview Vs. Submit

In Cascade 8, Save & Preview is the default option to save a draft and preview your edits. Save & Preview does not submit your work! After clicking Save & Preview the asset will reload with your edits, and a message will appear in the top right corner of the editing pane. This temporary message confirms that a draft has been saved and prompts you to Submit your work before fading away. You can select the “Click Submit” link text in the message before it disappears or the blue Submit button at any point.

If you’d like to skip the Save & Preview option and submit your draft, you can click the three-dotted button at the top right corner of the editing window. A window will appear to “Check Content & Submit”. If you click the button Cascade performs guided content checks before submitting.

NOTE: After clicking the blue check mark after the guided Check Content & Submit process, you save your work in Cascade. You still need to publish it to the live site.

Submit Vs. Publish

Submitting a page or asset saves that version in Cascade and allows other users to view your changes. When you return to that page or file in Cascade, even after logging out of the system, it will display the most recent updates that were submitted. However, submitting does NOT put your pages or files on the web. You must publish them.

Publishing is the process by which your pages, folders, or other assets are copied from Cascade and put onto one of McCormick’s public web servers. Publishing a page, folder, or other asset, makes that content visible on the web. Conversely, un-publishing removes content from the web.
Publishing or Un-publishing Your Assets

Clicking “Submit” or “Check Content & Submit” at the top right of the page you're editing saves your changes in Cascade. However, it will not yet appear on the web.

After submitting your changes, your page still needs to be uploaded to the web server. That process is called Publishing.

The publishing process is simple:

1. After submitting, click the “Publish” tab at the top of the page preview window. You can also hover over the page in the left navigation panel and click the white down arrow that appears next to the Asset Name and select “Publish.”

2. You’ll see two areas of the screen, where you’ll configure the publishing process for your pages:

   - **Output:** This area displays in what kind of outputs you’ll be publishing your edits to the servers.

   - **Destination:** This area shows to which servers you’ll be publishing your edits. Here you should see two options with check boxes. Those options are the two servers you can publish to:
“Development Server” is your site’s development server, on which you can test your website. You can view pages published to this environment at http://mccormick-dev.tech.northwestern.edu.

“Live Server” is the live server. This option makes your content fully live and viewable by the public.

Both will be checked by default. If you want your changes to go live immediately, select “Submit.” If you want your changes to show up on the development server only (for example, you might want to show someone a set of proposed changes to your website), uncheck “Live Server,” leaving only the “Development Server” checked.

**Options:** “Generate a publish report message,” if checked, means that you’ll receive a message within Cascade’s internal messaging system (viewable from your Dashboard or from the “Messages” link in the Quick Links menu) confirming that your page was published, and what errors, if any, occurred during publication. This is good to have, but not necessary.

“Publish” and “Un-publish” mean exactly what they seem to:

- “Publish” updates the page you’ve altered on the server
- “Un-publish” removes the page from the server entirely.

3. Once you’ve selected the configuration you want, click “Submit” to publish your page. You’ll get a confirmation message in a green bar at the top of the page.

**Publishing is generally immediate and can be done as often as needed.**

To view your latest published changes in a browser, you may need to refresh the page or clear your browser’s cache so it pulls the most recent information from the server.
The un-publishing process is simple:

1. Go to **More→Un-publish** and make sure you have the correct destination selected for un-publish task.

![Un-publish option in a content management system](image1.png)

2. Locate and click the **Submit** button to un-publish. This will remove the asset from the live server but it will stay in Cascade.

![Submit button in a content management system](image2.png)

3. To ensure that the un-published asset doesn’t show in the navigation of your site and stay out of publish queue, re-select the asset and go to **Edit** tab. Change the **Display in Navigation** setting to **No**. Then, go to **Configure** (Properties for a folder) and uncheck **include when publishing** checkbox. Locate and click **Submit** to save your changes to Cascade.

![Configure options in a content management system](image3.png)

4. You may need to republish the parent folder of this asset if the asset you just un-published appears in the left navigation of your site. If the page appears in the top navigation, please republish the _navigation folder.
**Warning:** When you un-publish, a visitor attempting to view that item will receive a *Page Not Found* message. If this is problematic for your organization, you should upload or create an asset using the old asset’s name.

### Publishing the Top Navigation

Publish the `_navigation` folder when any updates to the top or secondary navigation have occurred. This includes reordering items in the dropdown menu, adding or removing pages or sections in the dropdown menu or changing a Display Name of an asset that appears in the menu.

### Writing for the Web

When creating web content, remember two important ideas:

- **Make your webpages easy to scan.** Visitors are generally looking to find the information they need quickly and move on.

- **Make your webpages easy for search engines to find.** This is called *Search Engine Optimization (SEO)*.

Having excellent content isn’t of much use if users can’t locate it by searching. While
there are no guarantees when it comes to SEO, implementing the following best practices may result in better search results.

In addition to improving SEO, the practices mentioned below will improve the experience of visitors to your website and are an important part of complying with accessibility standards for the web.

**Optimize Asset Names**

In Cascade, the names of the actual files and folders are called Asset Names. Asset Names also become part of the webpage’s URL that is visible in the address bar of web browsers. It's important that they're consistent and optimized for search engines.

Asset Names should always be:

- made up of **keywords** relating to the content
- formatted as **lowercase**
- separated by **hyphens**.

**Do not use spaces or capital letters.**

For example, "research-laboratory-staff" and "guidelines-for-faculty-publications.pdf" follow best practices for Asset Names.

It’s also best to **avoid using dates** in Asset Names. This prevents you from having to create a new file or change the Asset Name if you need to update that information. For example, "student-handbook.pdf" is better and easier to maintain than "student-handbook-feb-2013.pdf." This also saves you the trouble of having to recreate the links to that document on your webpages.
Use Descriptive Page Titles
The page title is the phrase that appears in the top of the web browser bar while a user views a page. Search engines weigh page titles heavily when determining search results. This information also appears as the page title at the top of your webpage’s content area.

In Cascade, you can edit the title of your page under in the Edit tab, in the “Inline Metadata” section where it says “Title.”

Include Metadata
In Cascade’s page editor, below the Display Name and Title fields, you will see fields for Keywords and Description.

In the Description field, type a descriptive, concise sentence explaining the contents of the page you’re working on. This description will appear on Google’s search results pages.

Include relevant search terms in the Keywords field. This will also help search engines like Google find your webpages.

Optimize Your Copy
• Make your page copy simple and concise.
• Break it into more numerous small paragraphs.
• Use bullet points whenever possible.
Use Headers and Subheaders

Google's search engine (and Northwestern’s internal search appliance) gives more weight to pages containing search terms in header tags.

In addition, usability studies have repeatedly shown that users scan web pages, rather than setting out to read them from top to bottom. This means that concise copy and frequent (but judicious) use of subheadings is vital to making your pages useful to your readers.

Using headings and subheadings frequently is also important to building ADA-compliant pages: Screen readers used by people with visual impairments detect the HTML code that indicates headers (<h1>, <h2>, <h3>) and pay more attention to them than they do to ordinary paragraph copy — even if paragraph copy is set in bold or italic.

To create a heading or subheading in the Cascade content management system, select the text you wish to use as a header, then, in the Cascade Editor window, click the “Format” drop-down menu:

- For headers in the content areas of your webpages, use “Heading 2”
- For subheaders, use “Heading 3.”

The importance of a heading descends as its number ascends — information used as a Heading 2 should be more important than that of a Heading 3.

With this website template, you should not use any “Heading 1” formatting, since Cascade automatically formats your site title to that heading.
Link Frequently and Use Keywords

If you mention a page or document in your text, link to that page or document, particularly if it’s necessary to complete the task your visitor is trying to accomplish.

When choosing what words to activate as your link, it’s best to link to the key words in that sentence, not the entire sentence. Also, avoid writing “click here” as your link.

Take the example of this sentence with a “click here” link:

“Professor Smith has worked extensively with the Smith Catalysis Laboratory (click here for more info).”

It’s better to create the link like this:

“Professor Smith has worked extensively with the Smith Catalysis Laboratory.”

For detailed instructions on adding links in Cascade, see the “Inserting and Editing Links” section of this guide.

It is also important to fill in the “Title” of your link.

The text you enter into the “Title” field shows up as the “tool tip” text that appears over a link when a user hovers their mouse over it on a finished page.

Not only can this information be extremely helpful when navigating our website, it’s also a requirement to keep a web page compliant with ADA standards.
Use Alt Tags on All Images
Cascade requires you to fill in the “Alternate Text” field (producing what’s known as an “Alt” tag) when including any photograph. The Alt tag text becomes the image caption on the page. Therefore, it’s important to use complete sentences to describe what’s shown in a photo. Alt tags are a requirement for ADA compliance.
Module 3: Images, Documents & Videos

Preparing Images
Before you upload your images into Cascade, it’s important that they meet best practices for the web, which may require modifying image dimensions and file sizes before putting them into Cascade.

With the McCormick template, you are using for your website, photos should follow the guidelines below and be cropped to the following dimensions prior to uploading into Cascade. Image sizes are measured in pixels (px). See the "Image Size Cheat Sheet"

Resolution of all images should be 72 pixels per inch (ppi). You can adjust the resolution of images in a photo editing program.

All McCormick staff can download the latest version of Adobe Creative Cloud software (includes Photoshop, InDesign, Illustrator, Acrobat, and more). Find instructions and info at http://www.it.northwestern.edu/software/adobe

There are a few important things to keep in mind when preparing images:

- Keep the aspect ratio (the ratio of the width of the image to its height) the same as the original file in order to prevent distortion. No squashed heads!

- Do not increase image dimensions. If you increase an image’s size to something greater than its original dimensions, this will create a pixelated effect. Start with a larger image and size down as necessary.

- If you’re using Photoshop, be sure to select “Save for Web & Devices” when saving your image and adjust the quality to keep the image’s file size under 60 kilobytes (60k) for larger photos.

Generally .jpg and .png file types work well for most images and photos. Use .gifs for smaller images with blocks of color or animations.
**Uploading Image/Doc**

1. After navigating to the content page of the website you are editing, select “Add Content” > “Image – JPG GIF PNG SVG” for images and “Add Content” > “Document – PDF TXT DOC PPT POT XLS” for documents.

2. You can either drag and drop the file to the noted area or choose one from your computer. When the file is uploaded, you’ll see a preview and the dimensions of the file. Do not alter the image size in Cascade. All image resizing should be done in Photoshop or another photo editing software before uploading the image to Cascade.
3. Once you’ve found and attached the file, the name of the file will be populated in the “File Name” field above.

   a. You can then edit the name of the file in the field. Be sure the File Name of your new file follows the guidelines mentioned above (e.g., use keywords, all lowercase, no spaces, words separated by hyphens). Also specify the proper file extension (e.g., .pdf, .doc, .xls, .txt)

   b. Placement Folder: Click this link to specify in which “images” or “documents” subfolder the file will be stored. By default, any image file will be stored in the “images” folder and any document will be stored in “documents”

4. Click Save & Preview. The next screen shows you a preview of the file. This is just a draft of the file you just uploaded. If the file looks okay, locate and click the blue Submit button on the editing screen.

   You can upload more than one image at a time by zipping the files in one folder or nested folders on your computer first. Cascade will unpack the images in the same folder structure in Cascade.
Inserting an Image on Page

1. Place your mouse cursor in the area of the copy where you want to place an image, and click on the “Insert / Edit Image” icon (the mountain and the moon picture) in the toolbar.

2. Choose whether you want to create an internal or an external image. An internal image (default option) is a file that is already in the system, or one that you upload. (An external image is one that you link to using a URL. This option is rarely used and is for images hosted by external sites.)

3. Next to Image, you will see the “Choose File” icon. Click on the icon.

   ![Image chooser window]

   In the new image chooser window, you can either navigate to an existing image using the default Browse option, search for an image, or click on the Upload option to upload a file. If you choose to upload a new image into Cascade, **always upload new images to the images folder**. If you are going to be working with a lot of images, you may want to create sub-folders under the “images” folder to keep them organized.

4. Once you have the image selected, click Choose to close the image chooser window. The image path will appear in the “Insert/Edit Image” window.
5. In the Image Description field, type in a text description of what the image depicts in a complete sentence. This required text becomes the image’s caption on the page and ensures that if the image doesn’t load properly, or if a screen reader is being used, the user can still understand what the content is.

6. While you can specify the width/height of the image here, it is highly recommended that you size photos outside of Cascade, as explained in the section of this guide called “Preparing Images”.

7. Click “Ok” for the image to be placed within the copy you selected.
**Working with Images**

Using the tools below you can shift the layout of your inserted images or edit and replace the images on your webpages.

**Assigning an Image Class**

If you’re planning on aligning an image to the right or left you must use the “Formats > Custom” menu to assign it a “class.”

**Aligning an Image to the Right or Left**

1. Select the image in the Edit window.

2. Click the “Formats” menu and then “Custom” menu. Select `image_floatRight` or `image_floatLeft`.

This will align your image to the right or left, and add padding around it, which keeps page text from getting too close.

**IMPORTANT:** Image styles are “additive,” meaning the code created when you choose a style or alignment is not removed if you choose another style for the image. To change an image style or alignment, you must first select the image and click the “Format > Clear Formatting” tool from the tool bar menu. That step removes the previous alignment. Then you can select a new style or alignment from the “Formats > Custom” drop down menu.
Editing and Replacing Images
You may want to alter an image once you’ve added it to a page:

- Locate and click the appropriate folder. Typically, images are saved under images folder.

- Click the image you wish to edit or replace. This will display a preview of the image or file (some files will not display) in the main Cascade window.

- Toward the top of the main window, locate and click **Edit**. The edit screen will load in the main window.

  ![Edit Screen](image1.png)

  - On edit screen, you will see the option to replace the image and a toolbar that allows you to edit it. Make appropriate changes and click on **Save & Preview** button.

  - You will be redirected to the image preview screen and get a confirmation popup at the top of the screen stating a draft was saved. If everything looks, click Submit to save your changes permanently in Cascade.

- Go to Publish tab and publish your changes to the live site.

  ![Save & Preview Screen](image2.png)
Next, go to **More Relationships** tab and publish all relationships if the file has any. You will need to select the checkboxes to select the assets that you want to publish.

**NOTE:** You need to publish relationships only when you move, rename or delete a document or a webpage, or when you replace an existing document with a new one. You don’t need to publish relationships when you’re making any changes in the content itself.

If you have an alternate version of an image that you would like to upload in the place of the current image:

- Navigate to the existing image file in the “images” folder.
- Once the file is selected, click “Edit,” then use the “Upload” option to upload your new image. Cascade will point to the new image instead of the previous one.

Replacing your images assets this way instead of creating whole new files prevents clutter in your images folder.

**Inserting Video on Page**

You have the ability to embed a video from YouTube so that it plays on one of your site’s webpages.

To embed a video so it displays on one of your pages:

1. Go to that video’s page on YouTube.
2. Copy the video url from the address bar
In Cascade, select the Video Reel icon and paste the YouTube video url in the File/URL field. Uncheck "Constrain Proportions" in the next line and enter the proper video dimensions: **670 x 377** for the basic page.

Click Ok. A rectangle will appear in your editing window indicating its placement on the page. You can preview the video only after submitting your edits to Cascade or updating and viewing your Draft.

**Important:**

Do not use the embed code method of inserting videos on your page. You will receive an error message while previewing in Cascade and on the live site if published.

**Note:** If you do not enter the dimensions, the video will display with large black bars above and below it.

Publish this page to see how it appears on the web by following the instructions in the section of this guide called “Publishing or Un-publishing Your Assets”

**Image/Video Size Cheat Sheet**

Images must be cropped to the desired size before uploading to Cascade, using Photoshop or other programs.

Always select “Save for Web & Devices...” in Photoshop. Adjust quality of image to balance image quality vs. file size. File size of images affects page load time and data usage on the new website template is responsive, so **images will change in size and location** depending on the browser width or the device being used to view the website. Below are the specifications people should use to create and upload their images; the rest happens automatically.
mobile. Note suggested file sizes below (e.g., 10k, 40k, etc.).

All image resolutions should be 72 pixels per inch.

Dimensions noted below are in pixels.

If your image is a logo or has solid bands of color, save it as a .gif file to reduce file size.

Header Images
These images must be **770 x 375px wide**. Try to keep file size below **100k**.

Images in Body Area of Basic Pages

*Full width images (spans full width of content area):*
Images that span the full width of the main content area should be **670 pixels wide**. Try to keep file size around **60-80k**, depending on image size. Height can vary.

*Images using “image_floatLeft” or “image_floatRight” styles:*
If you want to wrap text around the image, when using “image_floatLeft” or “image_floatRight” image styles:

Keep your image **under 250-300 pixels wide** (about half the content area). Again, height can vary.

Smaller images should be around **40-60k**.

Images on People Listings Pages
Thumbnail images should be exactly **100 x 100px**, around **10-12k**.

Images in Sidebar Features
Microsite and program site administrators may want to add sidebar feature slides on their sites. Slide images should be **242 x 170px**, around **30k**.

Videos in Body Area of Basic Page
Embedded YouTube videos should be **670 x 377px**.
Module 4: Cascade Basics II – Structural Additions/Changes

Creating Section Folders
The first step in creating your site’s structure is to create the folders that organize your content.

When creating a new section of your site, you will use the Section Folder asset, which creates both a folder with an “index” page inside. Both the folder and index page must be edited. You’ll learn more about index pages in the next section.

It is highly recommended that you create a **Section Folder in Cascade for each top-level link or section** you would like to appear in your left-hand navigation, even if you only plan to have one webpage in that section. There are two reasons for using folders this way:

- **Should you decide to add more webpages or content to a section of your site in the future**, you will already have the folder in place that is properly named and ready to contain those additional pages.

- **Should you decide to expand an area of your website from a single page to a section containing multiple pages**, without a proper folder structure, you would need to change the Asset Name and location of that one page and possibly others. Since the Asset Name becomes part of a page’s URL, this could lead to multiple broken links for visitors who return to your site after the adjustment.

It’s best to start off with a folder structure that allows your website to grow.
Since Cascade generates your site’s navigation from folders and their names, it’s important to name them properly. This begins when you create a folder.

1. For this example, we’ll create a “student-projects” folder which will contain pages telling visitors about McCormick student projects.

2. In the Menu bar, click “Add Content,” and then click “Section Folder.”

3. Replace the default “section” name in “Folder Name” (Asset Name) field with your new name. In this case, call it “student-projects.”

**NOTE:** The names of all assets in Cascade, including folders, should be lower-case and should substitute hyphens for spaces. No Cascade Asset should contain spaces in its Asset Name. In addition, it’s important to use keywords in your Asset Names. The Asset Name becomes part of the URL path.

4. Make sure that the “Placement Folder” shown is the one where you want the new asset to “live.” You can change the Placement Folder by clicking the input section. This will open a new window that will let you choose the correct Placement Folder.

   In our example, since we want the “students” folder to appear as a top-level link in the site’s navigation, put it directly in the Site Name folder (Here, McC-McCormick) which is indicated by [/]. If it is not chosen by default, select the folder and click “Choose.”

5. The section below contains the Display Name for your new section folder and the option to display it in the left navigation. New folders you create will be displayed in the navigation by default unless you select “No” in the dropdown.

   A Cascade asset’s **Display Name** is the name that appears in the left navigation panel and the page’s breadcrumb navigation.
Enter a Display Name. Display Names should substitute “&” for the word “and” since space is limited in the left sidebar. In our example, you can name it “Student Projects.”

6. In the area marked at the top with “Properties,” there are two checkboxes that should be checked by default:

   “Include when indexing” means that the pages within this folder will be included (and show up in) the left-hand navigation of your site.

   “Include when publishing” means that this folder and its contents can be published with the rest of your site, so they will appear on the live website.

7. Click “Submit.”
Editing Index Pages

Once your section folder is created, you'll notice an “index” page inside it. The index page is the webpage that a browser automatically displays when a visitor navigates to a folder. It’s the default or “start page” for visitors to that section of your website.

- From the preview window of the index page, go to the **Edit** option.

  The **Display Name of the folder**, rather than the index page, will appear in the breadcrumbs and left-hand navigation of your website.

  The **Title** will appear at the top of the content area of your page and also in the browser’s title bar.

  To improve your search engine optimization (SEO), complete the Keywords and Description sections. (See “Optimizing Your Content” for more information about improving SEO.)

- When finished, click the “Submit” button at the bottom of the page.
Creating Webpages (Second-Level Navigation)

Pages that are not the “index” page in a folder will appear to a visitor as a second-level of links in your website’s left-hand navigation.

1. **(Optional):** Navigate to the folder where you want to create a new webpage. (If you don’t do this now, you can choose the destination folder in a moment.)

2. In the top Menu Bar, click “Add Content,” then choose “Basic Webpage.” The “New Page” window will appear in your Main Panel.

3. Give your new webpage a **Page Name**.

   **Since your Page Name becomes part of that page’s URL, it is best to give your page a Page Name that uses lowercase keywords separated by hyphens. Do not use any spaces.**

4. If you didn’t already do so in Step 1, select the “Placement Folder” link and navigate to the site folder where you want to put your new page.

5. Enter your new page’s Display Name and Title in the appropriate fields, and (if you have it ready) place your new page’s content in the main content field.
6. Click “Submit.”

**NOTE:** You will need to manually publish your changes; see “[Publishing or Un-publishing Your Assets](#)” for more information on publishing pages.

---

**Creating Third-Level Navigation**

The website template used by McCormick allows for the left-hand navigation to display up to three levels at once, which enables you to better organize areas with a large amount of content.

If you would like to create a third level of navigation, create a new folder inside one of your other folders. Then repeat the steps above to create a new section folder and addition pages as needed.

**NOTE:** You will need to publish all folders affected by your changes for the left-hand navigation on your website to reflect the latest updates.
Folder Order: Changing Your Site’s Navigation
This section explains how to change the order of folders, subfolders, and assets in Cascade.

The left-hand navigation of your website is determined by the order of the folders and assets in Cascade. You can reorder the folders and the webpages contained within those folders, which will then change the order of links in your site’s left-hand navigation.

In this example, we’ll be changing the left navigation of a subsection of the site.
1. In the navigation panel, hover over a desired sub-folder and click “>” to display its content on the site content panel.
2. Click the column header marked “Order.” The assets should reorder from lowest to highest. If they don’t, click “Order” again to reverse the sort order. Note that this sorting is necessary for any re-ordering to work.
3. Click and drag each folder/file to the desired position or use the arrows at right to move them up or down in the order. Your changes will be saved automatically when you navigate away from the folder.

NOTE: For these changes to display on the web, you must re-publish the entire folder you’ve re-ordered. See “Publishing or Un-publishing Your Assets” to learn more about publishing your website folders.

Copying Folders/Files
To copy a single folder or file, click on the folder or file and select Copy from the top menu. Specify the new system-name for the copied asset and new location. Submit.

To copy multiple folders or files at once:
- Click on the parent folder of the asset
- Check the boxes of those you want to copy
- In the dropdown box below the asset list, select Copy
- Specify copy location

Moving Folders/Files
To move a single folder or file, click on the folder or file and select Move from the top menu of the site content page. You can also hover over assets in the left navigation panel and right-click and select “Move” from the contextual menu.
On the next screen, select a New Folder. This opens a window that allows you to view folders within your site.

In the folder navigation window, you can choose from the list of Recent folders, or Browse to the new folder, or perform a Search.

Click the Choose button to confirm the appropriate folder and to close this window.

You’ll go back to the Move page screen where you’ll see New Folder field populated with the new folder that you just selected.

- Check Un-publish Content to remove the page from its original location on the live site as well as Cascade. **IMPORTANT**: If you do not check this box, a copy of the page will remain in its original location on the live site with no way to edit it in the future.

Locate and click Move button.

You are then taken to the page preview screen. A message at the top of the asset will confirming that the asset has been moved to the selected folder.
To move **multiple** folders or files at once:

- Click on the parent folder of the asset(s)
- Check the boxes of those you want to Move
- In the top box menu, select **Move**
- Specify the new location of the asset(s)

*NOTE:* There is no way to un-publish files from their original location while moving multiple files at once. Files should be un-published first by selecting Publish › Un-publish.

**NOTE:** If you’re moving an asset that has been on the live site for a while, you might consider planning a redirect from the old url to the new url. Contact [web-updates@mccormick.northwestern.edu](mailto:web-updates@mccormick.northwestern.edu) if you need help with this step.
**Renaming Folders/Files**
If you wish to update the **Asset Name**, you’d need to **Rename** it.

1. Find the asset in your navigation panel and click on it.

2. From the preview window, go to the **More > Rename** option.

3. Next, enter a new name for your asset in **New Page Name** field. For folder and files, you will see New Folder Name and New File Name fields. Make sure that the name you enter here is all lower case. Replace any spaces with dashes.

4. After you’re done making your changes, save the page and publish it to the live site. See **Publishing or Un-publishing Your Assets** section of this document for further instructions.

When we say rename an asset, we are talking about changing the **Asset Name**. Renaming assets in Cascade will change the URL of the asset on the website. However, we recommend never renaming an index page. Every folder should have an index page.

*NOTE:* If you’re renaming an asset that has been on the live site for a while, you might consider planning a redirect from the old url to the new url. Contact [web-updates@mccormick.northwestern.edu](mailto:web-updates@mccormick.northwestern.edu) if you need help with this step.
Publishing Folders/Files

You can publish individual pages, multiple pages, and entire folders.

- **Individual** pages
  - Click the Publish tab on the page.
  - Choose which server to publish to (development or live or both)
  - Request will be sent to the automated publisher
  - Any images on the page will also be published, no need to publish them separately

- **Multiple** pages
  - Select the parent folder of the pages to be published
  - Check the boxes of the pages to be published
  - In the top box menu, choose Publish
  - **Cannot** choose which server to publish to (must publish to all)

- **Entire** folders
  - Select the folder to be published
  - Click the Publish tab on the page.
  - Choose which server to publish to (development or live or both)

You can also hover over assets in the left navigation panel and click the white down arrow that appears and select “Publish” from the contextual menu.
Deleting Folders/Files

- Click on the asset
- Click the More option and the Delete option in the dropdown menu.

- Check Un-publish Content while deleting to remove the page from the live site as well as Cascade. IMPORTANT: If you do not check this box the page will remain on the site with no way to edit it in the future.
- Cascade also displays alerts for what pages/assets are linking to the file and will need to be updated before deleting.

- Deleted files stay in Recycle Bin for 15 Days

You can also hover over assets in the left navigation panel and click the white down arrow that appears and select “Delete” from the contextual menu.

Development Server

The McCormick site has a development environment which is essentially a copy of the entire site accessible at http://mccormick-dev.tech.northwestern.edu. This location is not indexed by Google and can only be accessed by sharing its url.

The development server can be useful for publishing pages for others to review who do not have access to Cascade before making that page live. See more details on this in the "Publishing or Un-publishing Your Assets" section of this guide.
Module 5: Program Page Types

People Listing

People listing pages are a great way to feature anyone in your program (faculty, staff, students). They allow you to upload an image of that person, along with their contact information, and a description of what they do for your program.

To create a people listing page first go up to your toolbar in the content page and select “Add Content”. After selecting the dropdown menu select “People Listing”.

After selecting the “People Listing” option from the dropdown menu you will be transferred to your new page.

First, fill out the Page Name (all lower case, separated by hyphens). And, choose the Placement Folder i.e. the location in the website where this new page will exist. Remember, the Page Name becomes part of the page’s url.

Next, fill out the inline metadata. Learn more on how to fill out this section in the "Include Metadata" subsection of this guide.

**NOTE:** Anything with a yellow star next to it has to be filled in before you can successfully submit and save the page (First Name, Last Name, Contact).
Main Content
The People Listing page has the same options for a header image/slideshow, jump menu and body content as a regular page. However, if you do not need to include any content before the listing of people then you can start entering content in the People Group area. This is where you will be adding people, uploading their images, describing their role, and filling out contact information.

Attach a **photo cropped 100px by 100px** of the person you'd like to feature. Remember, images must be cropped and uploaded to Cascade **before** editing the listing page.

Fill out the first name, last name and any other additional information that you would like. We suggest filling out all fields if possible.
Adding Groups

If you would like to format your page with different headers or groups all you have to do is **click on the green plus icon** under Main Content >> People Group. This will add an additional header and group to insert and organize photos.

For example, if you are creating a people listing page for your master’s and PhD students you could organize them by creating two separate headers (Master’s Students, PhD Students).

**Layout Options**

You have the option to display people's information (to the right of their image) in one or two columns for each group you add to the page. The layout defaults to two columns. You may want to use only if two columns may be severely uneven.
Adding People

You are most likely going to have several people listed on this page, so it is important to know how to add additional people. All you have to do is **click on the green plus Icon** under Main Content >> People Group >> Person.

Every time you want to add another person all you have to do is **click on the green plus icon** and it will add another content field.

Deleting People

If you have added too many people or have a person who is no longer with your program all you have to do is **click the red icon** on that person’s content area.

Changing the Order of People Listed

If you would like to change the order of the people you have created you have to **select the purple down or up arrows**. You can move people up and down to organize your page alphabetically or by hierarchy.
Sidebar
The sidebar regions of this page are the same as the basic page type. You must at least fill in contact information before submitting the page.

Example:

NOTE: It is important for you to update this page when people change positions, leave the program, or get additional responsibilities.
Linking to People

If you have many people listed on your page, you may want to link directly to a person rather than make a website visitor browse the entire list to find a specific person. To link directly to a person on your people page, at the end of the page's url, add a hash mark # followed by the first and last name of the person in all lowercase letters and separated by hyphens:

```
url.html#firstname-lastname
```

Our example page is the McCormick marketing contact page at http://www.mccormick.northwestern.edu/marketing/contact-our-team/index.html. To link directly to Emily Ayshord, we'd add #emily-ayshford to get http://www.mccormick.northwestern.edu/marketing/contact-our-team/index.html#emily-ayshford. Now, when we follow this url, the page view starts right above Emily's details:

**IMPORTANT:** If the person has any spaces within their first or last name, replace that space with a hyphen and keep all punctuation!

For example, to link to a person whose first name is "J. Edward" and last name is "Colgate", the hash you’d add at the end of the url would be #j.-edward-colgate.
Faculty Listing

Faculty listing pages are a great way to feature your entire list of faculty in one place. These pages can feature faculty one of two ways:

- Pull profile information from the main McCormick site
- Enter relative information in fields for those people who do not have core or affiliated profiles on the main McCormick site.

Make sure that the faculty you want to have featured on your faculty listing page have profiles on the main McCormick site first (if applicable) before creating or making additions to Faculty Listing pages.

Creating a Faculty Listing Page

To create a faculty listing page, go to the toolbar and select “Add Content”. Select “Faculty Listing” from the dropdown menu.

After selecting the “Faculty Listing” option from the dropdown menu you will see the fields for your new page.
First, fill out the Page Name (all lower case, separated by hyphens) of your page. And, chose the Placement Folder i.e. the location in the website where this new page will exist. Remember, the Page Name becomes part of the page's url.

Next, fill out the inline metadata. Learn more on how to fill out this section in the "Include Metadata" subsection of this guide.

NOTE: Anything with a yellow star next to it has to be filled in before you can successfully submit and save the page (First Name, Last Name, Contact).

**Body Content**
The body content section allows you to insert important information before your faculty profiles. If there is anything important that a user needs to know before viewing your faculty members, insert it here.

**Faculty Groups**

**Adding Headers**
If you would like to format your page with different headers or groups all you have to do is *click on the green icon* under the Faculty Group. This will add an additional header and will allow you to organize your faculty listing page.

For example, if you are creating a faculty listing page for your core, affiliated, and emeritus faculty you could organize them by creating three separate headers (Core Faculty, Affiliated Faculty, Emeritus Faculty).
Adding Faculty Members
You will most likely add several faculty members on this page, so it is important to know how to add additional faculty. **Click on the green icon** under Faculty Group >> Faculty Member.

Cascade is going to ask you if the faculty member has a McCormick profile. "Yes" will be selected by default. Click the section where it says "Choose Page". A new window will open up to select a page.

This window is set to view pages on your program site. However, faculty profiles, both core and affiliated, are stored on the main McCormick site. To choose pages from the main McCormick site, **click “Browse” and search for "McC-McCormick" on the search bar.**

The navigation panel below will update to reflect the main McCormick site. Navigate to the "research-faculty" folder toward the bottom of the tree. Click the folder to expand it, and then click the "directory" folder. Core McCormick faculty profiles are stored in the "profiles" folder. Affiliated faculty profiles are in the "affiliated" folder.

Once, you've found the individual page that corresponds to the faculty member, click it and then click "Choose". The individual faculty member's information will now be included on your program’s Faculty Listing page.

Every time you want to add another faculty member all you have to do is **click on the green icon** and it will add another content field.

If the person you'd like to feature does not have a McCormick profile and you cannot create an affiliated profile for him/her, you will have to enter their information on this
page. Select "No" for "Does this faculty member have a McCormick profile?" and fill out the appropriate fields.

**Changing the Order of Faculty Members**
If you would like to change the order of the faculty you have created you have to select the purple up or down arrow that is located next to the addition icon. You can move faculty members up and down to organize your page alphabetically or by hierarchy.

Sidebar
Once you have your faculty members organized, fill out the sidebar information. This is one of the last steps to creating the page. Make sure to fill out the contact info (mandatory) along with any related links and call-outs.

Example:

**NOTE:** It is important to update this page when new faculty members join your team, when they change positions, or leave the program.

*You can link directly to a specific faculty member in the listing page by adding #firstname-lastname to the url. See "Linking to People" p. 58 for more details.
Faculty Profiles

Faculty profiles for all McCormick faculty – whether they are tenure-track, tenured, or clinical faculty with paid, budgetary appointments OR are affiliated faculty (e.g. program adjuncts, lecturers, emeritus, research faculty, courtesy appointments, etc.) – are kept in the main McCormick site (McC-McCormick) in Cascade:

McC-McCormick / research-faculty / directory /

Budgetary / Tenure-track faculty profiles are kept in the “profiles” sub-folder.

Affiliated faculty profiles are kept in the “affiliated” sub-folder.

Budgetary / Tenure-track Faculty Profiles (e.g. Core faculty)

Profiles for McCormick budgetary faculty are created by Jason Grocholski (j-grocholski@northwestern.edu).

Once the profile has been created, program staff may add to or edit the content at any time, with two exceptions:

- Only Jason Grocholski may edit the official position titles of faculty members. Program staff should not change faculty titles in the McCormick faculty directory.

  To request a title change, email Jason (j-grocholski@northwestern.edu).

- To change a faculty’s preferred profile photo, please email the ORIGINAL photo (the raw, uncropped image) to Christa Battaglia in the marketing department (c-battaglia@northwestern.edu).

  Marketing will then ensure that the photo is cropped and connected to the correct faculty profiles as needed.
If a faculty member has public information in the Annual Report system – including their CV, publication lists or detailed research descriptions – that information is automatically fed to their McCormick faculty profile in Cascade and will appear on the profile page, once the profile has been republished.

To edit that information, you’ll need to log into the Annual Report system. See below for more information about that process.

If a faculty member is not in the Annual Report system or they have not yet been added to it, then all their information is contained and managed from their profile in Cascade.

In either case, a faculty’s basic information (see the right box) is kept in their faculty profile in Cascade.
Updating Basic Faculty Profile Information

Program staff may edit faculty members’ basic information on their profile in Cascade, including:

- name
- contact information
- affiliation
- education
- biography
- research interests
- significant recognition
- significant professional service
- patents

To edit a faculty profile, choose that person’s profile from the “profiles” folder and select “edit”.

Under the edit window, you may change their display name if needed (please format display name as “Last name, First name”).

Under the Departments area, faculty profile should already be connected to their department(s).

If you need to add a new department affiliation, you may do so by using the “+” to add a new Department group. Choose the appropriate department from the drop-down menu.

*Note: The biography field can be used to add background and personal information not covered by other areas.*
If this person is the **Department Chair**, select “yes” next to the question “Is this the Department Chair?”

To enter **centers** with which the faculty member is involved, type them into the field under “Centers.” Use the “+” button to add additional centers.

To add or edit **education** information, enter it into the field called “Education”. Please be mindful of proper formatting, as this information will appear on the faculty profile exactly as it is entered into Cascade.

Fill out the field titled Research Interests. This should be a brief summary of the interests, topics, or research area(s) that the faculty member practices. This content will appear on any pages that show faculty directory listings.
The next three sections enable you to list additional **optional** information for a faculty member:

**Courses Taught** – the titles of any courses that faculty regularly teaches

**Significant Recognition** – the names/years of professional awards, honors or recognitions for that faculty member

**Significant Professional Service** – any roles or honorary positions held by the faculty member such as magazine editor or board member

For each of the above three areas, clicking the “+” button under each category will enable you to add another line of information. **For these fields, list only one item, achievement, or recognition per line.**

Use the **Patents** field to list or describe any relevant patents filed or held by the faculty member. Please be mindful of proper formatting, as this information will appear on the faculty profile exactly as it is entered into Cascade.

**Other Information** is an area where you can show any additional information for that faculty member, such as “In the Classroom” to explain their teaching philosophy. Again, please be mindful of proper formatting, as this information will appear on the faculty profile exactly as it is entered into Cascade.
Featured Items

This section is an optional area that allows you to include additional documents or links on a faculty profile. It will display on the left side of the profile, underneath the faculty’s profile photo.

**Section Title** creates a title for the whole area (e.g. “Featured Projects” or “Publications”).

**Caption** is where you should enter the text that will appear on that link, such as “View a list of projects” or “Download a complete list of publications”

**Linked Document** is where you can use the page chooser icon to select a PDF or other file to link to.
You also have the option of putting a website address in the URL field, instead of choosing a PDF or other file, if you’d like to link off to an external website. Use the + or − icons to add or remove additional documents or links in this area.

Updating Annual Report

Faculty CVs, publication lists, and detailed research descriptions are kept and managed in the "McC Faculty Directory Info" section of the Annual Report. **This content is accessible and editable by faculty and program staff at any time throughout the year.**

Edit this information by logging into the Annual Report ([https://ar.mccormick.northwestern.edu](https://ar.mccormick.northwestern.edu)) and clicking on "McC Faculty Directory Info" in the left sidebar. Program staff may need to select "McC Faculty Directory Info" again, once you have chosen the faculty member's name.
Affiliated Profiles
Academic program staff may create a new affiliated faculty profile at any time. All Affiliated Profiles are kept under the McC-McCormick Site Name folder.

Creating a new Affiliated Profile
To create a faculty listing page, select the affiliated faculty folder in research-faculty/directory.

Next, click “Add Content” on the Cascade sidebar as seen below. Select “Affiliated Faculty Profile”.

After you select the “Affiliated Faculty Profile” page it will bring you to your new page. Make sure that your new page is kept under the research-faculty/directory/affiliated placement folder. Note that all the Affiliated Faculty profiles have to be saved in that placement folder.

Inline Metadata
Next, you have to fill out the Inline Metadata. This includes the Display Name, Keywords, and Description. Make sure your Display name is formatted as Last Name, First Name.

Content
Please fill out as many fields as possible. Obviously, some are more important than others (name, email) but we encourage you to fill out as much as possible in order to let the user get important information about the affiliated faculty member.

Also, if the affiliated faculty member has a profile photo please attach it. Make sure you have already uploaded the photo/photos in Cascade before attaching them on this page.
Images
All profile photos associated with affiliated profiles should be stored in "images/research-and-faculty/directory/affiliated" on the McC-McCormick site. Not your program site. Go to Add Content >> Image – Affiliated Faculty – JPG PNG to add images. They will default to the proper location on the McCormick site. The image size is 250px X 250px as noted in the profile photo field.

Additional Content
Cascade offers the following options:

*NOTE: You do not have to fill out all of these fields but we encourage you to fill out the fields that are important to the faculty member.

Titles: Please fill out the Job Title(s) of the Affiliated Faculty Member.

Departments: Please select the dropdown menu and select the department that the faculty member is associated with.

Affiliations: If the faculty member is affiliated with a Master’s of Science program, please select the dropdown menu and the corresponding program.

Websites: If the faculty member has a research website or personal website please paste in the URL and text.

Centers: If the faculty member has any research centers please enter the name of that center accordingly.

Education: Please enter which degrees the professor has earned, along with the school and year. (Ex: BS Mechanical Engineering, Johns Hopkins University, 2007)

Biography: Please fill out basic biographical info for this faculty member not covered by the other sections in here. See pg. 68 for more information.
**Research Interests:** Please fill out the faculty member’s research interests.

**Publications:** If the professor has any selected publications please note them here. (Ex: Wilson, A. D., J. A. Schultz, and T. D. Murphey, "Trajectory Optimization for Well-Conditioned Parameter Estimation", IEEE Transactions on Automation Science and Engineering, vol. PP, issue 99, In Press.) *Also, if the faculty member has a CV or Publications list you can upload them in this section.*

**Courses Taught:** If the faculty member is teaching any specific course fill them out in this field.

**Significant Recognition:** If the faculty member has won any awards, or received any significant recognition, please fill it out here.

**Significant Professional Service:** If the faculty member has any significant professional service, fill it out accordingly.

**Patents:** If the faculty member has any patents list them in the text box.

**Featured Items:** If the faculty member has any projects they’d like to feature, please fill out the project title, the caption, the document or the URL. This will appear directly under their profile picture.

Example:
Student Profiles

To create a new Student profile, go to Add Content and select “Student Profile” from the dropdown menu. Enter a Page Name for the profile and take note of the parent folder path: this is where on the site your profile will be stored.

Insert necessary information in the fields below. The **Summary** appears on the profile listing page only. Information entered in all other fields will appear on the page.
Student Listing Pages

Once an individual profile has been created for a student, that person can be added to a listing page.

To add a new person to the listing page, go to the edit window of that page and scroll down to the People Group section.

This functions the same way as the Faculty Listing Page, except you’ll be choosing profiles created on your site rather than the McC-McCormick site. Choose the appropriate profile page from your website and the information will be pulled in this listing page for each person.
News Articles

There are two options for publishing news related to your program: create an internal article or link out to an external URL for news items that exist on other websites. Previously, there was a third option to pull a main McCormick site article into your program site. This is now an automatic process and McCormick articles tagged for your program will automatically show up in the news feed.

News articles are stored in news/articles/[year]. New articles created are stored in this location by default.

To create a program News Article, go to Add Content ➔ News Article

Update the Page Name field with appropriate text (lowercase and hyphens between words). Give the article a Title and Summary. The Title appears at the top of the article. The Summary does not appear on the article page. Rather, it appears in the news feed displayed on the program news index page and homepage.

The keywords and description fields are for search engines. Follow the same rules as the basic page for these fields.

The Start Date will appear on the article under the Subtitle and it indicates when the article can be indexed and published.

The External Article URL field should only be filled out if the news asset will link out to a news source that is external to your McCormick website. If so, the web address, beginning with "http" should be entered here.

The External Article Source field should be populated to note the source of an article. This will create a tag after the article summary. Entering “The New York Times” in this field will produce a tag like that in the image below.
The second option is to create an original article. In this case, all of the fields mentioned above EXCEPT the External Article URL field should be filled out. Then, content should be entered in the Department News Article area.

The Subtitle appears on the news article page under the Title on the news article (followed by the date). The text of the article should be entered in the Story Content area. An original article can feature a header image, slideshow or video. To enter media, click the Featured Media section to expand and then click on the Video or Images option. NOTE: these options are mutually exclusive.
If Video is chosen, select "Yes" for "Would you like to embed a feature video?" and then follow the instructions for "Inserting Video on Page".

Captions are required for all featured video and images. The fields for the header image or slideshow are set up in the same way as those for the basic page. Note the different sizes for the slideshow images.

If you are planning to share this news article to Facebook, please add a 200px x 200px image file to the Thumbnail Image field at the top of this region. This image will be shared alongside the article title, subtitle and link on Facebook.
If you have a related link, enter the text and url in the appropriate fields.

It will display at the bottom of the article in this style:  "This is a related link"
News Article Sidebar

Below is a sample news article on the Mechanical Engineering site. The right sidebar of every program news article displays the **four of the most recent news stories** from a pool of McCormick marketing articles tagged for the specific program and original articles from the program. Links to the stories appear in reverse chronological order.

The "Join Us" section in the sidebar displays the program's social media and is controlled from the program's homepage. Below that is a region to link to a news related item such as a newsletter signup. The Header, Copy, Link Text, and Link can all be customized. This bottom area is the only region in the sidebar you have control to edit.

You can edit these fields in the **news/news-sidebar** asset.
News Index

The Program "news/index" page displays a reverse chronological list of the most recent marketing articles tagged for the program and the most recent original articles created by the program. News Articles can be searched by Keyword and Year. The sidebar regions of this page can be edited just as those of a basic page. No content should be entered in the main content areas of this page.

Note: It may take up to an hour for newly created articles to appear in this index.
Event Listing

Program Events are listed on the "events/index" page of the website. Events are added/edited through planitpurple.northwestern.edu. No action is necessary inside Cascade to update the events feed. Events added in planitpurple will appear on the event listing page and the homepage of the program website within three hours.

The sidebar regions of this page can be edited just as those of a basic page. No content should be entered in the main content areas of this page.
Course Listing
The Course Listing page displays a searchable index of all course descriptions entered in Cascade. Each row of the table corresponds to an individual course description page asset and includes a link to that asset. IT must be contacted to update course table headers and can be reached at web-updates@mccormick.northwestern.edu. Introductory text, which will appear below the page title, can be entered on this page. All other information displayed here is pulled from the individual course description. This page should be republished anytime an individual course description is updated, added or removed.
The course order that appears in the table can be controlled through the Folder Order of the descriptions folder. To do this, select the descriptions folder and select "Order" in the new pane. The courses assets will display in the same order as the Course Listing. Reorder any course by clicking the area to the right of the course name and dragging it to a new position.
Course Description
All course descriptions are stored in the "courses/descriptions" (or in some cases, "curriculum/descriptions") folder.

To create a new course description, go to Add Content >> Course Description. After updating the Asset Name, you'll have two options: create a new description by filling out the fields below, or choose an existing description from a McCormick department site.

Create a new description
Creating a new course description is the default option. If you choose this option, first fill in the Course Subject, Course Number and Course Title. You cannot submit or save the page asset until these fields have been filled out.
Then, fill out the Quarters >> Quarter section for each quarter taught this academic year. Check the corresponding quarter in the Offered field. If it's not being taught this year, use one quarter section and select “None” for the Offered field. The Course Number and title will still appear in the table, but nothing will appear in the quarter fields. If you do not want the course to appear in the table at all, you can select “Configure” on top of the editing window and then uncheck "Include with indexing." **Do not delete or move course assets once created.** Other sites may be linking to your assets and you should receive a warning indicating what pages are linked if you attempt to delete them.

To add another quarter, click the green plus icon .

Enter the prerequisites, course description text and attach any syllabi in the fields below the Quarters section. Information from these fields will be displayed only on the course page, not in the Course Listing.

For changes to the subject, title and quarters offered to appear, users should publish both the description page and Course Listing.

Example:
Choose an existing description
If you select the option to "Choose from a McCormick department site," all the fields below this option will be replaced with a page selector. When a course page from another site is chosen, the information from the asset will be pulled into a course page on your program site.

Click the white box below “McCormick Department Course” to Search to navigate to the site and course asset needed. A new window will open where you can use the search bar to search and select the site that contains the asset you're looking for. Once entered, the navigation tree for that site will appear below in the window. Navigate through the "courses" or "curriculum" folder to find and choose the asset.
Confirm and the window will close. You'll be returned to your site asset with the page chooser field updated. Select submit to create the asset that pulls information into your site. This asset should be published along with the course index page. If you need to edit some information that appears on the page, you must contact the department from which you took the asset or create your own version with details specific to your program through the "Create a new description" option.
If you would like to include a header image or slideshow at the top of the page, click the downward arrow ∨ to expand the Main Content > Header Image(s)/Slider section.

As you answer the series of "Yes/No" questions about your image(s)/slideshow, options will appear to further indicate specifications such as:

- one header image or a multi-image slider

- automatically cycle through images on the page or leave it up to the user to advance the slideshow

- advance slides every 20 seconds (default) or for a number of seconds you specify

If you've chosen to create a multi-image slider, the area to add the image and caption for each slide will appear below the options:
Click the downward arrow -chevron to expand this section and edit the fields for the slides. Add more slides by clicking the green plus sign at the top right of the expanded slide area.
• **Headline** – Displays in bold font across the announcement

![Image](126x467 to 512x693)

<table>
<thead>
<tr>
<th>Announcement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headline (max 60 chars)</td>
</tr>
<tr>
<td>Link Type</td>
</tr>
<tr>
<td>Link Text</td>
</tr>
<tr>
<td>Internal Link</td>
</tr>
<tr>
<td>Anchor</td>
</tr>
</tbody>
</table>

• **Link Type** – You have the option to include an internal link from the McCormick website, external link or no link at all. This link will be added to the button.

• **Anchor** – You can add an anchor to create a link within the page. You must fill in the field for the link Text (the text that will appear in the menu on the page) and the Anchor Name (the section of the page you wish to jump to). Then, you must create anchors with the same names used in the Body Content section in the area of the page you wish to link to. See the "Anchor Links" section of this guide to learn how to create anchors.
Sections – Main Content

Below the Slider Features and Announcement, you will find the Section option. There are several types of Sections for each page and you may add multiple Sections to each Page.

Section Formats

To set the format for a Section, select a choice from the Module Type drop-down. Formats are listed in alphabetical order. *In Cascade, scroll to the bottom of the dropdown to select WYSIWYG + Images / Video / Sidebar List and WYSIWYG w/ Buttons.

Overview of the options here:

1. WYSIWYG + Images / Video / Sidebar List
2. Callout
3. Features
4. Programs
5. Testimonial / People Feature
6. News
7. Whole Brain Footer (controlled by Marketing)
8. Events -- not shown
9. WYSIWYG w/ Buttons -- not shown
**Section Content**
When you switch the format, all related content will remain in Cascade. This means that you may select Callout, enter the header content, and then switch the format to Events and the header content will remain the same. This gives you the freedom to try different formats to achieve your desired layout without re-entering content each time you change the format type.

**Section Order**
Add new Sections with the + button. Delete sections with the X button. Reorganize Sections using the up or down arrows.

**Section Headers**
Generally, each Section includes: Module Type, Title, Subhead and Paragraph. These fields display at the top of the Section and they are optional.

---

Our active collaborations with many other Northwestern Engineering departments as well as the Feinberg School of Medicine, Lurie Children's Hospital, Shirley Ryan AbilityLab, and Stellenbosch University allow us to push the boundaries of our interrelated research areas.
Section Separator

Generally, each Section will give you an option to further separate each section with either a spacer or separator bar which can be placed on the top or bottom of the section.

Separator

Add gray bar between modules

- [ ] Separator Top  [✓] Separator Bottom

Spacer

Add extra space above or below modules (70px)

- [✓] Spacer Top  [✓] Spacer Bottom
**Callout Section**

Callouts highlight important information from your department and give the end user an opportunity to find content within the site. Generally, a callout includes a title, subhead, paragraph content and a button.

![Featured Program](image)

**Callout Paragraph**

Paragraph content for a Callout Section is added as Callout Text. Within this WYSIWYG, you may format content, create links and add buttons. **Note:** See field below for adding standard buttons.
SPACING NOTE: If a separator appears when adding a callout, it has been carried over from the module on which you clicked the green plus sign to create it. It can be removed by temporarily changing the Module Type field selection, unchecking the Separator box and switching the Module Type back to Callout.

Northwestern’s innovative Architectural Engineering and Design (AE&D) program blends architectural principles and state of the art engineering to prepare uniquely whole-brain engineers.
**Callout Background Options**

There are several background options available, including a custom photo background, switching between backgrounds will not affect the title, subhead or Callout Content.

**Callout Width**

Keep the text narrow at 835px or wider at 1120px (as shown below)
Callout Buttons
Add a standard Button to your callout in the Link Type field. Link the button to internal NU content or external sites. Customize the button text in the “Button Text” field.

Callout Anchor
Add an anchor to the Callout Section link to link to a section of a page.
Events Section

The Events Section auto-populates upcoming events from the department newsfeed. Only 5 of the soonest events will appear on the page. Past events will not appear.

Events

<table>
<thead>
<tr>
<th>Date</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>THU NOV 14</td>
<td>BME Seminar Series: Michael King, PhD</td>
</tr>
<tr>
<td>THU NOV 21</td>
<td>BME Seminar Series: Alumni Speakers</td>
</tr>
<tr>
<td>WED NOV 27</td>
<td>Thanksgiving vacation begins 6 p.m.</td>
</tr>
<tr>
<td>THU NOV 28</td>
<td>Thanksgiving Day</td>
</tr>
</tbody>
</table>

SEE ALL EVENTS

Events Content

Choose to display the event feed from your department (default is set to “Yes”)

Would you like to display your events feed?

*Only 5 soonest events will appear on the page. Past events will not appear.*

- [ ] Yes
- [ ] No
Features Section

Facts and Figures

Leaders who shape the future of industrial engineering

Connections to Chicago

Students and researchers benefit from connections to a variety of industries and nonprofits ranging from transportation to healthcare to logistics to data science.

Diverse research funding

Department faculty have grants from 11 federal agencies and a wide range of industry partners.

25 other departments with which we actively collaborate

across five Northwestern schools

Feature Section with Columns using facts and icons

Academic Offerings

Uniquely innovative and interdisciplinary

Undergraduate Programs

Become a whole-brain thinker by working at the intersection of careful analysis and wild creativity. Earn your bachelor’s degree, supplement your Northwestern education with a certificate, minor, or key course and conduct research alongside pioneering faculty.

View undergraduate programs

Full- and Part-time Master’s Programs

Our diverse master’s degree programs are tailored to fit the constant changes of modern workplaces and your personal career needs. You’ll find yourself poised to make immediate and lasting impact, both at work and in the broader world.

View full-time programs

View part-time programs

PhD Programs

Prepare yourself to innovate and perform at the highest level of academia or the private sector by studying and working alongside our world-class faculty members on advanced engineering research topics.

View PhD programs

Interdisciplinary Programs

We offer a dynamic ecosystem of interdisciplinary programs ranging from design, entrepreneurship, leadership, and complexity. Transcend the boundaries of disciplines and learn to reframe problems to discover innovative ideas and solutions.

Segal Design Institute

Farley Center for Entrepreneurship

Center for Leadership

Feature Section with Boxes using images
Features
Layout
You will choose whether you want boxes or columns under the Layout section and you will be guided to options for each feature. You must create at least 2 features and a maximum of 4 can be added.

Features / Columns

Layout
Boxes

Feature Box Style
Image

Features (you can have 2-4 per row)

Feature Image

Image (440 x 248px)

undergraduate.jpg

Image Alt:

Feature Content

Title
Undergraduate Programs

Content

Become a whole-brain thinker by working at the intersection of careful analysis and wild creativity. Earn your bachelor’s degree; supplement your Northwestern education with a certificate, minor, or key course; and conduct research alongside pioneering faculty.

View undergraduate programs

Link Type

Internal  External  None
News Section

The News Section auto-populates upcoming news from the department newsfeed. You may add two custom news features. There are two formats for the News Section which include: 1) one large feature with three title-only features or 2) four small features.

News Layout

Select a format option for the news section. There are two choices, both options allow you to create custom content for two small features (see custom news content below).

Department News

Create Structures That Supply Thermal Energy: A New Book for Transforming Built Environments

Creating Structures That Supply Thermal Energy: A New Book for Transforming Built Environments

CEE Welcomes UNSAM Students

As part of the 100,000 Strong in the Americas Innovation Fund

CIV_ENV 295: Climate Action

CIV_ENV 295: Climate Action

CEE Homecoming Alumni Breakfast

CEE Homecoming Alumni Breakfast

2 Column- 1 Large Feature, 3 Title-Only Features
Feature one large video or image with a headline / summary and three title-only features. The title-only features are from the newsfeed but you may customize 2 articles (See “Custom News Content” below). Customize the Large Feature as follows:

**Feature Type:** select article, video or custom for the large feature.

**Large Feature Video Link:**
When you select the Video Feature Type you must include a link to the video (including https://)

**Large Feature Image:** Article and Custom features require a Large Feature Image that is 672px by 378px.

**Alt Text:** Add alternative text to display if the image doesn’t render. This also improves site accessibility and SEO.

**Headline:** Optional custom headline for Large Feature

**Summary:** Optional custom summary of Large Feature

**Internal Link:** Optional link to article within NU newsfeed

**Anchor:** Optional internal link to reference within the Department Page
'Barcoding' DNA Vesicles for Selective Biochemical Reactions

A new method from Professor Neha Kamat selectively drives the fusion of lipid nanoparticles, opening the door to new and complex biochemical behaviors and potentially transforming drug delivery technologies.

John Rogers Elected to the National Academy of Medicine

With election, Rogers becomes one of only 25 people ever to be named to the National Academies of Sciences, Engineering, and Medicine.

Bioelectronic Implant Could Prevent Opioid Deaths

Project co-led by Professor John A. Rogers receives NIH grant worth up to $10 million over next five years.

Highest-throughput 3 Column - 4 Small Features Across

Display four features, including article headline and summary, from the department newsfeed. See “News Content” below to customize two articles in the feed.

Custom News Content

You may create up to two custom news items. Select “Yes” to create custom news items to replace articles in the newsfeed. Click “Choose Page” to select internal news article. Create a custom headline to display in your newsfeed by typing title in the “Override Article Headline” field. To add a second custom article, click the + button next to Article.
# Programs Section

This section organizes department offerings into three categories: undergraduate, graduate and affiliated.

## Custom Programs Content

Program content is displayed in three columns labeled: Undergraduate, Graduate, Affiliated.

<table>
<thead>
<tr>
<th>Undergraduate</th>
<th>Graduate</th>
<th>Affiliated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bachelor of Science in Biomedical Engineering</td>
<td>Master of Science in Biomedical Engineering</td>
<td>PhD students may enroll in these additional programs:</td>
</tr>
<tr>
<td>Combined BS/MS Degree Program</td>
<td>PhD in Biomedical Engineering</td>
<td>- Pathophysiology and Rehabilitation of Neural Dysfunction Training Grant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Graduate Training Program for Magnetic Resonance Imaging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DPT/PhD Engineering Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Biotechnology Training Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Chemistry of Life Processes Training Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- General Motor Control Mechanisms and Disease Training Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Interdisciplinary Biological Sciences Training Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Molecular Biophysics Training Program</td>
</tr>
</tbody>
</table>

Explore special programs in this department, including undergraduate honors, certificates and minors, internship opportunities, and study abroad.
The majority of content for the Programs Section is added by marketing. However, you may include optional content by selecting “Yes” and entering content in the WYSIWYG editor. Content will display at the bottom of each column.

Include optional undergraduate programs content (if applicable)

- Yes
- No

Optional Content (appears after program listings, if applicable)

Explore special programs in this department, including undergraduate honors, certificates and minors, internship opportunities, and study abroad.
Testimonial / People Feature Section

Highlight individuals in your department with images or quotes. Create a slider of content by adding multiple testimonials or people features.

Testimonial / People Feature Layout

There are two layout options, Testimonial (quote) or People Feature.

Slide Order

This section displays content as a series of slides. If you add multiple slides you may choose to set the order or to display slides in a random order. To randomize the slides, select “Yes.”
Click the arrow button to rearrange the slide order, click the + button to add a slide, click the - button to delete a slide.

**Custom Testimonial / People Feature Content**

Testimonial Content

<table>
<thead>
<tr>
<th>Name</th>
<th>Diego Klabjan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship</td>
<td>FACULTY</td>
</tr>
<tr>
<td>Title</td>
<td>Professor and Director of Master of S</td>
</tr>
</tbody>
</table>

Content

As Director of the Center for Deep Learning, I lead large projects developing models and software for deep learning that engage many PhD students and post-docs.

Both Testimonial and People Feature content offer the following fields:

- **Name**: add the name of the featured person
- **Relationship**: add the role of the individual (i.e. Faculty)
- **Title**: Add the specific title of the individual. It does not have to be in all caps, the title will be formatted automatically.
- **Content**: Add information you would like to feature. Content will automatically appear in quotes for the Testimonial slides.

**People Feature Content**

People Features require an image that is 266 x 266px. The image will automatically be formatted into a circle.

Image (266px x 266px)

`klabjan-diego.jpg`
People features offer the option of including a link to internal or external content. If you do not want to include a link click “None.”
WYSIWYG + Images / Video / Sidebar List Section

As the name implies, there are 3 different layouts for this section. The Header section and WYSIWYG remain the same in all three but you have an option to include either an image or slideshow of multiple images, a video or sidebar list.

Northwestern University recognizes that computers and computational thinking are changing everything: the way we work, play, think, shop, and plan. At the Department of Computer Science, we aim to lead that change.
**WYSIWYG + Image / Video / Sidebar List Layout**

In this Module Type, you have the option of selected Images to create a slideshow, a video or a right sidebar list. In whatever case, the Main Content remains the same. What you write in this paragraph will be shown to the left of your Video, Image or Sidebar List.

**WYSIWYG + Image Layout**

*About the Department*

Creating a resilient future through innovation, analysis, and design

In today's complex world, civil and environmental engineers play a central role in defining the future: they build, preserve, protect, and restore systems to support human activities and minimize our footprint on nature. They play an essential role in solving many of our most pressing problems, and their work affects every aspect of modern life, including shelter, food, energy, water, air, transportation, commerce, and recreation as well as public and ecological health.

Ranked among the nation's premier research and academic departments in the field, the Department of Civil and Environmental Engineering is meeting the systemic challenges of tomorrow with the next generation of leaders in research, academia, industry, and public service.

*Read a message from the chair>*

*Learn more about the department>*

**Example of WYSIWYG + Image**

At the top of the WYSIWYG + Images / Video / Sidebar List is where you select the type of feature you would like, either Images, a Video or a Sidebar List. In this case we are covering adding an Image(s).

The Main Content will remain consistent for each feature. Anything you write here will appear to the left of your feature.

This is what will appear if you select “Images” -- You have an option to choose one image or multiple to create a slider.
Image --- Your image must be 858px x 453px, saved and published in Cascade.

Alt Text --- This has two purposes, one this text will show if for some reason your photo will not load and most importantly this helps our sites be accessible.

Caption Title --- This text will be shown at the bottom of the image in bold.

Caption --- This text will follow the Caption Title in normal text.

As you answer the series of "Yes/No" questions about your image(s)/slideshow, options will appear to further indicate specifications such as:

- one header image or a multi-image slider
- automatically cycle through images on the page or leave it up to the user to advance the slideshow
- advance slides every 20 seconds (default) or for a number of seconds you specify
Below these options, you will also be able to add additional images. Like the first image, all of the following images must be 858px x 453px and include an Alt Text. Captions are optional. More photos can be added by selecting the green “+” sign in the upper right-hand corner.
Computers and computational thinking are changing everything. At Northwestern University's Department of Computer Science, we aim to lead that change.

Northwestern Computer Science intentionally positions itself as an ideal hub for interdisciplinary research by fostering a culture of inclusivity and promoting collaborations across a wide range of disciplines at our numerous top-ranked schools. In addition, the University continues to deepen its commitment to this field of study by radically expanding the faculty and developing state-of-the-art facilities to support our vision. This is a combination that offers our researchers and students an experience like no other.

Read a message from the Chair ➤

Watch our video: The Power of Computer Science

Video Link --- Here is where you can add a link to your video

Alt Text --- This has two purposes, one this text will show if for some reason your photo will not load and most importantly this helps our sites be accessible.

Caption Title --- This text will be shown at the bottom of the image in bold.

Caption --- This text will follow the Caption Title in normal text.
**WYSIWYG + Sidebar List**

**About the Department**

Transforming the way we work, play, think, and live

Northwestern Computer Science intentionally positions itself as an ideal hub for interdisciplinary research by fostering a culture of inclusivity and promoting collaborations across a wide range of disciplines at our numerous top-ranked schools. In addition, the University continues to deepen its commitment to this field of study by radically expanding the faculty and developing state-of-the-art facilities to support our vision. This is a combination that offers our researchers and students an experience like no other.

Read a message from the Chair

---

**List Header** --- This is an optional space to include a header for your list of links

**List Item** --- You must have a minimum of two links to add to your list

**List Item Text** --- This is the text that will be connected to your link

**Link Type** --- You have the option to include an internal link from the McCormick website, and external link or no link at all. This link will be added to the button.
**WYSIWYG w/ Buttons Section**

This section was designed to provide an option to add a button (or buttons) to the sections that do not offer a button like Programs or WYSIWYG + Images / Video / Sidebar List. Otherwise it functions very similarly to the Callout section with a plain white background.

**WYSIWYG w/ Buttons Layout**

![Buttons Layout](image)

*WYSIWYG w/ BUTTONS can be used to add buttons to the end of any section*

In this case, the header and paragraph sections are left blank and only the Buttons/Button section is filled in.

You can add more than one button by hitting the green “+” sign at the top right corner of the Button section.

All buttons will be purple as shown above. We’ll go into more detail below.
Enjoy the work-life balance benefits of living in a global city

Our department is located along the shores of Lake Michigan, only 17 miles from downtown Chicago. Those who join our department choose from a spectrum of suburban or urban home environments with some of the state’s best school districts, and find extensive internship opportunities, cultural and entertainment experiences, and a diverse population.

Example of a WYSIWYG w/ Buttons with Title, Subhead, Paragraph, and Button

**Paragraph** --- This section is more or less interchangeable with the Paragraph in the top section. If both Paragraph sections are filled out, the Paragraph from top section will appear first and this Paragraph will appear second.

**Button Text** --- The text entered here will appear on the button.

**Link Type** --- You can select an Internal Link and select a page from Cascade or an External Link. If you choose an External Link, be sure to include “https://”.

**Anchor** --- You have the option to add an Anchor tag to your link so that the user is sent directly to the area of the website you desire.
Quick Facts Section

This section highlights 4 (no more, no less) facts of your choosing. This section includes a header, icons, quick facts title and content, and an option to include a link.

Quick Facts Layout

The example above includes a Title, Subhead and Paragraph from the Header and has all of the Quick Facts Content, including a link.
Quick Facts Content

**ICON**
**Icon** --- Icons must be 94px x 94px
**Icon Alt** --- Include an alternative text for your image here

**FEATURE CONTENT**
**Title** --- This is what will appear in purple under the icon.
**Content** --- In this WYSIWYG, you have the choice to format the content as you like.
**Link Type** --- Here you can add either an Internal, External Link, or no link at all.
**Link Text** --- If you choose to add a link, it will appear at the bottom of your Quick Fact and this is where you add the text for your link.
**Anchor** --- You have the option to add an Anchor tag to your link so that the user is sent directly to the area of the website you desire.

Northwestern University’s Evanston campus
Easy access to Chicago’s STEM industries
Optional internships typically located in the greater Chicagoland area

Link Type
- Internal
- External
- None

Link Text
- See program overview

Internal Link
- Index
Whole Brain Footer Section—Controlled by Marketing
A footer will automatically display at the end of your page. Marketing controls the content of the footer.

Discover Our Whole-Brain Engineering Philosophy
We augment the analytical core of engineering with design, entrepreneurship, leadership, personal development, and unusual collaborations to imagine what’s next and take the world in a whole new direction.

LEARN MORE
Module 6: Other Helpful Tips

Mark Content for Review

You can mark your assets for review if you want to update the information on a regular basis or on a certain date. Assets that are marked for review will be listed in your dashboard under **Content to Review** section. To do this, follow the steps below:

1. Go to the site and select the asset you want to mark for review.
2. In the preview window, locate and click on **Edit**. This opens a new window.
3. In the next window, switch to **Metadata** tab. Scroll down to enter a review date and click **Save and Preview** button to save a draft. On the next screen, you’ll see the option to **Submit**. You don’t need to publish the asset after this step.
Versions

- Cascade retains the 90 most recent versions of an asset.
- To view previous versions, select an asset in the left navigation panel, click the More tab and click Versions.
- You should be presented with a table of all previous versions.
  - When they were last modified and who modified them.
- Locate and click the version you would like to view. A preview of the previous version is displayed in the main Cascade window.

- If you want to view other versions, you can click on More to see other viewing options. You can view an older version, view a newer version, view current version, delete the version or restore it. Notice that the More dropdown doesn’t list any of the in-context editing options like move/delete/publish.

- If you wish to roll back to the version you are viewing, click on Restore this version. Cascade will create a copy of the old version and this will become your newest version. You may edit this version or just publish to the live site.
Creating Line or Paragraph Breaks

- In WYSIWYG editor
  - Enter creates a new **paragraph**
  - Shift+Enter creates a **line break**
- If the text appears to be larger than normal make sure the block of text is formatted for **paragraph**.

When writing a **single line** of text, hit **Enter** to ensure that text is in a **paragraph**.

Basic Troubleshooting

Here are a few troubleshooting tips to try if you find a webpage isn’t loading correctly on the web:

**After checking that all the links and formatting are correct on your page in Cascade, be sure you have published the page.**

Try publishing the page a **second time** if:

- the page isn’t displaying the same on your website as it appears in Cascade
- the page isn’t loading correctly
- there are broken links on the page

If the page still doesn’t load correctly after publishing, it might be a **caching** issue related to your Internet browser:

- Try to reload the page in your browser without cache by selecting Ctrl+F5 (for Windows) or Cmd+Shift+R (for Mac).

If the page still doesn't load correctly, it may still be in the process of publishing. You can **check the publisher queue** in Cascade to see if that page (or other assets) is still in the process of publishing.

To check the publishing queue in the content page:

- Select the Help menu on the top right of the toolbar.
- Then select “Publish Queue”. There you can see what assets are in the process of publishing.

If the page has been published and the problem still remains, or the publisher appears to be stuck, you may **contact McCormick IT** at [web-updates@mccormick.northwestern.edu](mailto:web-updates@mccormick.northwestern.edu). IT may be able to address the problem.